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PROMATيمذيخ دنٛم ال  .1

 -انظٛذنٛخ الإداسح انًشكضٚخ نهشػبٚخ أٔلاً: 

:الإداسح انؼبيخ نزُظٛى يٕاد انزسٕٚك ٔالإػلاٌ

 انظؾٛؼ انًؾزٕٖ ػًبٌ انظٛذنٛخ ػهٗ  نهشػبٚخ انًشكضٚخ فٙ ئؿبسؽشص الإداسح

ٔانزؼهًٛٛخ انذػبئٛخ انًٕاد يٍ انًخزهفخ الأشكبل نكم ٔالأخلالٙ ٔانؼهًٙ

انًُبسجخ الإعشاءاد انذٔاء انًظش٘ ٔارخبر سٕق فٙ انًسزخذيخ ٔانزٕػٕٚخ

انًؼههخ رمٕو  الادػبءاد ٔانًخبنفخ ٔؽزف انظؾٛؾخ غٛش انًًبسسبد نمًغ

انًٕاد ٔرمٛٛى ٔالإػلاٌ ثًشاعؼخ انزسٕٚك يٕاد نزُظٛى انؼبيخ الإداسح

انظٛذنٛخ ٔالأعٓضح انخبطخ ثبنًسزؾؼشاد ٔانزٕػٕٚخ ٔانزؼهًٛٛخ انذػبئٛخ

سلايزٓب  يٍ نهزأكذ َششْب لجم انؾٕٛٚخ ٔانًجٛذاد انزغًٛم ٔيسزؾؼشاد نـجٛخا

انشػبٚخ رؾسٍٛ رشغٛغ انذٔنٛخ ٔثبنزبنٙ انًًبسسبد يغ رٕافمٓب ٔنؼًبٌ

فٙ ثبنزؾمٛك انًُزغبد كًب رمٕو نٓزِ انششٛذ الاسزخذاو خلال يٍ انظٛذنٛخ

ػمذ  ٔانزٕػٕٚخ ٔأٚؼب ٔانزؼهًٛٛخ انذػبئٛخ ثبنًٕاد انًزؼهمخ انشكبٖٔ

.انؼًم ٔؿشق الإداسح ئسشبداد ٔٔسش ػًم ؽٕل رذسٚجٛخ دٔساد 

يٕاد ػهٗ انًٕافمبد يٛكُخ يُظخ ئَشبء ٔرفؼٛلا نٓزا انذٔس انٓبو رى

 انذٔاء ْٛئخ فٙ انظٛذنٛخ نهشػبٚخ انًشكضٚخ ثبلإداسح ٔالإػلاٌ انزسٕٚك

 نهزؾٕل انًجزٔنخ انًكضفخ ٔانغٕٓد انًظشٚخ انؾكٕيخ رٕعّ ئؿبس فٙ انًظشٚخ

 ْٛئخ ٔأْذاف ٔاخزظبطبد يسإٔنٛبد ٔرؾمٛك انؾكٕيٛخ انخذيبد ٔنًٛكُخ انشلًٙ

 .1119نسُخ  151ٔ  151ٔانًُظٕص ػهٛٓب فٙ انمبٍََٕٛ سلى  انًظشٚخ انذٔاء

PROMAT: أْذاف ثشَبيظ ال صبَٛبً 

 انؼبيخ الإداسح رمذيٓب انزٙ انخذيبد كبفخ ٔيٛكُخ انشلًٙ انزؾٕل 

انجُٛخ  كفبءح ٔسفغ رـٕٚش فٙ ُٚسٓى ثًب ، الإػلاٌ ٔ انزسٕٚك يٕاد نزُظٛى

 ظم فٙ انًؼهٕيبد نزكُٕنٕعٛب الأيضم الاسزغلال خلال يٍ ثٓب انًؼهٕيبرٛخ

 .انجٛبَبد ٔؽٕكًخ انشلًٙ نهزؾٕل انًظشٚخ انؾكٕيخ رٕعّ

 ٔالإػلاٌ انزسٕٚك يٕاد ثًهفبد انخبص الإنكزشَٔٙ انزمذٚى خـٕاد رسٓٛم



 انزسٕٚك يٕاد ثًهفبد انخبطخ انـهجبد ٔاسزكًبل يزبثؼخ خـٕاد رسٓٛم 

 انششكبد اسزٛفبء سٕٓنخ ٚؼًٍ ثًب انًؼهُخ ثمٕاػذ انؼًم ٔسثـٓب ٔالإػلاٌ

نهـهجبد

 نسٕٓنخ انسبػخ يذاس ػهٗ انكزشَٔٛبً  انًمذيخ انًهفبد ٔرسغٛم ؽفظ

 اسزشعبػٓب

 ٔالإػلاٌ انزسٕٚك يًبسسبد رمٛٛى

 انزسٕٚك يٕاد نزُظٛى انؼبيخ رسٓٛم انزٕاطم ثٍٛ انششكبد ٔالإداسح

ٔالإػلاٌ

بً: انشكش ٔانزمذٚشصبنض

 انؼخى، الاَغبص ْزا ئرًبو فٙ سبْى يٍ نكم ٔالايزُبٌ انشكّش ثخبنض َزمذو أٌ َٕد

 يسٛشرُب فٙ ٔخٛش يؼٍٛ انًششٔع، ثٓزا ٔالاسرمبء ٔانُّغبػ الإنٓبو يظذس كبٌ ٔ

:يٍ كلاً  ثبنشكش َٔخض انزـٕٚش ٔ انزمذو َؾٕ

د/ تبيز ػصبو رئَس هَئت انذواء انًصزٍت

د/ رشا زیادة - مساعد رئیس ھیئة الدواء المصریة

 د/ شزٍٍ ػبذ انجواد رئَس الإدارة انًزكشٍت نهزػبٍت انصَذنَت

رجبئي رئَس الإدارة انًزكشٍت نهؼًهَبث سد/ ٍ

انًزكشٍت نهسَبسبث انذوائَت و دػى الأسواق الإدارةًَُز رئَس ان/ رضوى د

د/ إیمان فتحي – المكتب الفني لمساعد رئیس ھیئة الدواء المصریة

د/ وائم انسَسٌ انًذٍز انتُفَذً نًشزوع يَكُت انًوافمبث ػهي يواد 

 PROMATانتسوٍك والإػلاٌ 

د/ ٍبسًٍَ انخغَب انًذٍز انفٌُ انتُفَذً نًشزوع يَكُت انًوافمبث ػهي 

 PROMATيواد انتسوٍك والإػلاٌ 

يذٍز ػبو وفزٍك ػًم الإدارة انؼبيت نتُظَى يواد انتسوٍك و الإػلاٌ



انزشغٛم َظبو اسزخذاو .1

فٙ انغضء انمبدو ٚزى ػشع خظبئض َظبو انزشغٛم ثـشٚمخ يفظهخ شبيهخ نغًٛغ 

انًمذيخ ٔػشع انخـٕاد انًـهٕثخ انخذيبد  . 

 ػبيخ خظبئض 1.1

انذخٕل رسغٛم 1.1.1

 انخغوة الأوني انخغوة انثبََت انخغوة انثبنثت

 Sign inلى ثبنؼغؾ ػهٗ 

 نزسغٛم انذخٕل

ٚزى اخزٛبس َٕع 

Companyانًسزخذو 

اسى ٚزى ادخبل 

ٔ  Usernameانًسزخذو 

Passwordكهًخ انًشٔس 

للكیان التى تم الحصول 

علیھا من قسم سجل الشركات 

 company profile الالكترونى

بوحدة التحول الرقمى 

الصیدلي.



انششكخ ٔاعٓخ .1

 انشئٛسٛخ انظفؾخ 1.2

فٙ انغضء انمبدو ٚزى ػشع انخظبئض انخبطّ ثبنششكّ 

 Your“ػُذ اخزٛبس سؤٚخ لبئًخ انؼًم 

Worklist” ًيٕػؼ ثبنظٕسح ٚزى اظٓبس  بك ْٕ

عًٛغ انًٓبو انخبطّ ثبنششكّ انزٙ رى 

يٕاد نزُظٛى الإداسح انؼبيخ ئػبدرٓب يٍ 

:يضمٔالإػلاٌ انزسٕٚك 

يسزُذاد رؼذٚم انٕسق انًمذو يٍ  ●

غٛش كبفٛخ

رؼذٚم انًبدح انًمذيخ يٍ أعم  ●

انًٕافمخ

انٕسق انز٘ رى سفؼّ أصُبء  ●

انًشاعؼخ الأٔنٛخ

انٕسق انًشاد رؼذٚهخ يغ رؼهٛك  ●

نزٕػٛؼ سجت انزؼذٚم

ًٚكٍ نهششكخ ؿهت يبدح دػبئٛخ أٔ رؼهًٛٛخ 

أٔ رٕػٕٚخ عذٚذح أٔ يؼذنخ أٔ يًذٔدح ػٍ 

يٍ  ”New Material“ ؿشٚك انؼغؾ ػهٗ انضس

أػهٗ انظفؾخ انشئٛسٛخ أٔ انمبئًخ 

 انًٕعٕدح فٙ انغبَت الأٚسش 

يبدح دػبئٛخ أٔ  ؿهت ”Your Worklist“ لبئًخ انؼًم انخبطخ ثك

”New Material“ رؼهًٛٛخ أٔ رٕػٕٚخ عذٚذح أٔ يؼذنخ أٔ يًذٔدح

عند اختیار رؤیة تقریر حالة الطلب كما ھو موضح بالصورة

یتم اظھار جمیع الطلبات القائمة المقدمة من الشركة 

بتاریخ التقدیم ونوع الطلب المرسل إلى الإدارة 

ٔالإػلاٌيٕاد انزسٕٚك نزُظٛى انؼبيخ 

 ”Status Update Report“ رمشٚش ؽبنخ انـهت



انًكزًهخ كًب  سؤٚخ انـهجبدػُذ اخزٛبس 

عًٛغ انـهجبد ْٕ يٕػؼ ثبنظٕسح ٚزى اظٓبس 

انًكزًهخ نهششكخ

ؽٛش ٕٚعذ َٕػٍٛ يٍ انـهجبد

انـهجبد انزٙ رى انًٕافمخ ػهٛٓب  ●

)ثبنهٌٕ الأخؼش(

انـهجبد انزٙ رى سفؼٓب )ثبنهٌٕ  ●

الأؽًش(

 ”Completed Reports“ انـهجبد انًكزًهخ

فٙ ْزِ انشسبنخ ٚزٕفش نُب اخزٛبساٌ

 Highlightًٚكٍ ئسزخذاو ئخزٛبس  ●

لإخزٛبس انغضء انًشاد رؾذٚذِ ػُذ 

feedbackئسسبل 

 black outًٚكٍ ئسزخذاو ئخزٛبس  ●

لإخفبء انجٛبَبد انشخظٛخ

انظفؾخ " انًٕعٕد أسفم ًٍٚٛ Send Feedbackسص " ػهٗػُذ انؼغؾ 

 رظٓش سسبنخ  انشئٛسٛخ

 رٕػؼ آنٛخ ػًم ْزا الاخزٛبس

ؽٛش ًٚكٍ  " رظٓش انُبفزح انزبنٛخnextصس " ػهٗػُذ انؼغؾ 

 لإسسبنخ Submitصس  ػهٗ" ٔانؼغؾ feedbackئػبفخ ٔطف نم "



 انزمذٚى يهف 1.1.1

رمٕو انششكخ ؽٛش  ”Material Type“َوع انغهب رمٕو انششكخ ثبخٛبس أولاً 

 اخزٛبساد يخزهفخ 6ثبخزٛبس َٕع انـهت يٍ 

 Newرسزـٛغ انششكخ ئَشبء ؿهت عذٚذ ػٍ ؿشٚك ئخزٛبس  ●

Extensionرسزـٛغ انششكخ رًذٚذ ؿهت يسجك ػٍ ؿشٚك ئخزٛبس  ●

 انٕصبئك رؾذٚش ثسجت انظبنؾخ انًٕافمخ رؾذٚشرسزـٛغ انششكّ  ●

 ئخزٛبس ؿشٚك ػٍ انًٕافمخ يؾزٕٖ ػهٗ انزأصٛش دٌٔ انشسًٛخ

Variation 1

يٍ يشزك عذٚذ اػزًبد ثشلى عذٚذ ؿهترسزـٛغ انششكخ رمذٚى  ●

 Variation 2 ئخزٛبس ؿشٚك ػٍ يسجمًب يؼزًذح يبدح

 يٍ يشزك عذٚذ اػزًبد ثشلى عذٚذ ؿهترسزـٛغ انششكخ رمذٚى  ●

يخزهفبٌ َٕع أٔ/  ٔ ؽغى نٓب يسجمًب ػهٛٓب انًٕافمخ رًذ يٕاد

 Variation 3 ئخزٛبس ؿشٚك ػٍ انًؾزٕٖ ثُفس

رسزـٛغ انششكخ ؿهت ػذد يٍ إَٔاع انًٕافمبد انًخزهفخ فٙ ؿهت  ●

Combined اخزٛبس ؿشٚك ػٍٔاؽذ 



أونوٍت  ثؼذ ئخزٛبس َٕع انـهت ٚمٕو انًزمذو ثبنـهت ثاخزٛبس ثبََبً 

 ”Track“انغهب 

ئرا كبٌ انـهت فٙ ؽبعخ ئنٗ يٕافمخ سشٚؼخ لى ثاخزٛبس  ●

Fast  

Normalفٙ ؽبنخ ػذو انؾبعخ نًٕافمخ سشٚؼّ لى ثاخزٛبس  ●

ٔٚزى  ”Material Information“بَبَبث انًبدة  ثادخبلرمٕو انششكخ  ثبنثبً 

انخبَبد انًـهٕثخ انزٙ ٚزى رغٛٛشْب ثُبء ػهٗ رظُٛف انًبدح  يهئ

ػُذ ئدخبل انجٛبَبد  ٔٚشعٗ انؾشص انُؾٕ انزبنٙ َٕٔػٓب ػهٗ

انًـهٕثخ ؽٛش أٌ انششكخ ْٙ يسإٔنخ ػٍ عًٛغ انجٛبَبد انًذخهخ 

ًٚكٍ رؼذٚهٓب فٙ ؽبنخ اسسبل انـهت نلإداسح انؼبيخ نزُظٛى  ٔانزٙ لا

 :ٔالإػلإٌاد انزسٕٚك ي

يلاحظبث َوع انبَبَبث انًغهوبت ػُواٌ انخبَت

ػُذ اخزٛبس يبدح 

"Combined ٗٚغت انؾشص ػه "

ئدخبل الإَٔاع انًـهٕثخ 

(Electronic ٔأ Printed ٔأ

Electronic/Printed) 

ٚزى اخزٛبس أؽذ انخٛبساد يٍ 

 انمبئًخ كبنزبنٙ:

 Printed

 Electronic

 Radio/TV

 Printed/Electronic

 Materialَٕع انًبدح 

Type

ٚشعٗ انؼهى أَّ فٙ ؽبنخ 

الإراػخ  اخزٛبس يبدح

سٛزى  Radio/TVٔانزهفضٌٕٚ 

رهمبئٙ  Awarenessاخزٛبس 

 ٚزى اخزٛبس ثٍٛ:

Promotional – Educational - 

Awareness 

 Materialرظُٛف انًبدح 

Category 

ٚشعٗ انؼهى أَّ فٙ ؽبنخ 

اخزٛبس يبدح رٕػٛخ فٙ 

ٔانزهفضٌٕٚ أٔالإراػخ

" سزكCombinedٌٕيبدح "

يذح انًٕافمخ سُخ رهمبئٛب

ٚزى اخزٛبس أؽذ انخٛبساد يٍ 

انمبئًخ كبنزبنٙ فٙ ؽبنخ 

 انًبدح انغذٚذح:

 1 Year

 3 Years

Extensionٔ فٙ ؽبنخ ال  ٚزى  

يذح انًٕافمخ 

Requested Approval 

Duration 



اخزٛبس أؽذ انخٛبساد يٍ 

كبنزبنٙ فٙ ؽبنخ انمبئًخ 

 انًبدح انغذٚذح:

 1 Year

 2 Years

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

يٕاد انًزغٛشاد ٔ يبدح 

 انًذ

ػهٗ ؽست  Yes or Noٚزى اخزٛبس 

 يؾُٕٖ انًبدح

رؼًٍ انظٕس ٔ انشؼبس 

Pictures and slogans 

included 

فٙ  ْزِ انخبَخ غٛش يٕعٕدِ

يٕاد انًزغٛشاد ٔ يبدح 

 انًذ

Nameاسى انًبدح  ٚزى ادخبل اسى انًبدِ كُض 

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

 يبدح انًذ

ػهٗ ؽست  Yes or Noٚزى اخزٛبس 

يؾُٕٖ انًبدح

 Scientificيبدح ػهًٛخ 

Material 

ٚزى ادخبل انؼذد كشلى ٔ نٛس  ___

 كُض

ػذد طفؾبد انًبدح 

Number of 

(Pages/Slides/Screenshots)

إَٔاع انًُشٕس  ٚزى ادخبل َٕع انًُشٕس كُض ___

Publication Type

ْزِ انخبَخ يٕعٕدح فمؾ فٙ 

ًبدح "ان Combined "  

ٚزى ادخبل انؼذد كشلى ٔ نٛس 

 كُض

Combined material 

number انًٕاد  ػذد  

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

 يبدح انًذ

يٍ لبئًخ ٚزى ادخبل انزبسٚخ 

 انزٕاسٚخ انًشفمخ ثبنخبَخ

ربسٚخ أؽذس َششح 

 Date of theيؼزًذح 

approved leaflet (most 

recent) 

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

 انًبدح انغذٚذح

ٚزى ادخبل انزبسٚخ يٍ لبئًخ 

 انزٕاسٚخ انًشفمخ ثبنخبَخ

ربسٚخ أَزٓبء طلاؽٛخ 

 انًٕافمّ انسبثمخ

Invalidation date of 

previous approval 

ٚزى ادخبل انغًٕٓس انًسزٓذف  ___

 كُض

 انغًٕٓس انًسزٓذف

Target audience 



 أيبكٍ انُشش ٚزى ادخبل الأيبكٍ كُض ___

Dissemination venues 

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

يٕاد ٔ يبدح انًذ يغ 

نٍ ٚزى اسسبل انؼهى أَّ 

انـهت الا ثؼذ رؾًٛم ػذد 

رى ئدخبنّ انًشاعغ انز٘ 

ُْب

ٚزى ادخبل انؼذد كشلى ٔ نٛس 

 كُض

انًشاعغػذد   

Number of references 

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

 انًبدح انغذٚذح

 كٕد انًٕافمخ الأسجك ٚزى ادخبل انكٕد كشلى ٔ كُض

Previous Approval Number 

ْزِ انخبَخ غٛش يٕعٕدِ فٙ 

يٕاد انًزغٛشاد يٍ انُٕع 

انضبَٙ ٔ انضبس ٔ يبدح 

انًذ ٔ انًبدح انغذٚذح يغ 

نٍ ٚزى اسسبل انؼهى أَّ 

انـهت الا ثؼذ رؾًٛم ػذد 

انًشاعغ انز٘ رى ئدخبنّ 

ُْب

ٚزى ادخبل انؼذد كشلى ٔ نٛس 

 كُض

 ػذد يهفبد انًزغٛشاد

Number of Varied 

Documents  

Description ٚزى ادخبل انٕطف كُض ___  ٔطف انًبدِ

رابعا�: یتم ادخال بیانات المنتج”Product Information“  یتم إدخال المستحضر أو المستحضرات 

المتعلقة بطلب الموافقة وفي حالة مواد التوعیة سیتم ربط الاسم التجاري بالموافقة الصادرة، 

أما في حالة المواد التعلیمیة سیتم ربط الإسم التجاري أو العلمي الخاص بالمنتج بالموافقة 

على حسب محتوى المادة التعلیمیة المقدمة، لكن في حالة مواد التوعیة یرجى اختیار أقرب 

منتج یتوافق مع محتوى المادة المقدمة ولكن سیتم إصدار الموافقة بدون اسم المستحضر. 

-: اذا لم یجد الكیان المستحضر المراد ادخالة

ن  - فى حالة ان المستحضر ملك للكیا
. EDDB علیھا التوجھ لقسم حوكمة البیانات بوحدة التحول الرقمى الصیدلي لاضافتھ فى قاعدة بیانات الشركة
- فى حالة ان المستحضر ملك لكیان اخر والمراد تحویلة لھذا الكیان لتقوم بعمل المواد الدعائیة للكیان الاصلى 

یرجى من الكیان الاصلى مالك المستحضرتسجیل الدخول مرة واحد على البرنامج ثم توجھ الكیان الاخر للادارة العامة لتنظیم مواد التسویق والاعلان وذالك 
لتحویل المستحضرات علیھ

 



نهزمذٚى ثُبء ػهٗ  ”Checklist“لأوراق انًغهوبت اسفغ  ٚزى خبيسبً:

يـهٕة ادخبنٓب  ثبلأؽًشالأٔساق انًًٛضح يغ انؼهى أٌ  ثٛبَبد انـهت

 انـهت لإرًبو

 هبيت يلاحظبث اسى انخبَت

اٚظبل انذفغ 

Receipt

" انخبص ثبلإٚظبل كًب Receipt Codeثؼذ سفغ الإٚظبل رمٕو ثادخبل "

 Receiptنشفغ انًهف + " uploadصس  ػهْٕٗ يٕػؼ صى رمٕو ثبنؼغؾ 

Code"

سفغ انـهت  ٔفٙ ؽبنخ" يشِ ٔاؽذِ فمؾ Receipt Codeًٚكٍ ئسزخذاو "

 ًٚكُك ئػبدح 

" انخبص ثReceipt Codeّئسزخذاو "

انًبدح راد 

 انشٔاثؾ

Material with 

Hyperlinks -  

 ٚغت أٌ رزؼًٍ انًٕاد انغذٚذح أٔ انًزُٕػخ انًمذيخ ػهٗ ال

PROMAT  اسرجبؿبدhyperlinks  ّٛنشثؾ كم ادػبء ثبنًظذس انًشبس ئن

صُبئٛخ  hyperlinksأٔ ثبنًٕافمخ انسبثمخ. خـٕاد ئَشبء اسرجبؿبد 

الارغبِ داخم َفس انًسزُذاد ْٙ كًب ٚهٙ:

: َٕع انجشَبيظ انز٘ ٚذػى ْزِ اختز انبزَبيج انًُبسب .1

 PROMAT ْٕ Adobe انًٛضح ًٔٚكٍ رؾًٛهّ ٔلشاءرّ ػهٗ ال



Acrobat Pro 2 

: ٚغت ديظ انًٕاد انًـهٕثخ ٔانًشعغ انجًغ بٍَ انًستُذاث .1

 Portable )انًشاعغ( انذاػًخ ثبنزشرٛت فٙ َفس يهف ال

Document Format (PDF) ً٘ٚكٍ لشاءرّ ٔانجؾش فّٛ انز

اخزش انخـٕاد انزبنٛخ  :PDFإَشبء ارتببط فٌ يهف ال .3

Tools> Edit PDF> Link> Add or Edit 

اخزش انًُـمخ انزٙ رؾزٕ٘  : Drag a rectangleاسحب يستغَلاً  .4

ػهٗ الإدػبء فٙ انًبدح ٔ انزٙ رشٚذ سثـٓب ٔلى ثزغـٛزٓب 

  ثسؾت يسزـٛم فٕلٓب

 dialogue boxسٛظٓش :  “  box ialogueD -Create Link”إَشبء رابظ  .5

كبنزبنٙ: hyperlinkسزخزبس يُّ َٕع يظٓش الاسرجبؽ 

 Create Link > Link Appearance > Link Type > Invisible Rectangle

لإَشبء  dialogue boxداخم ال  : ”Link Action“حذد َوع الارتببط  .6

نشثؾ الإدػبء انًؾذد ثبنًشعغ انذاػى داخم hyperlink ساثؾ 

، اخزش انزبنٙ: PDF َفس يهف

Go to a page view; Create Link > Link Action > Go to a page view > 

Next 

 انًزجغ انذاػى نلإدػبء داخم َفس يهفلى ببنتحزن واختَبر   .7

PDF صى اخزش  و حذد انجشء انذً ٍذػى الإدػبءCreate Go to 

View > Set Link.

: كشس  way hyperlink”-“two لإَشبء ارتببط ثُبئٌ الاتجبِ .8

 7ثذءًا يٍ انًشعغ انذاػى فٙ انخـٕح  7ئنٗ  3انخـٕاد يٍ 

 .4ٔاَزٓٙ ثبلإدػبء انًٕعٕد فٙ انًبدح فٙ انخـٕح 



 ٔ ئسسبل انـهت انًمذو انـهت رفبطٛم سبدسبً:

ؽغى انًهفبد انزٗ ٚزى سفؼٓب 

انًشبس يٛغب  ٠١١ثؾذ الظٙ  

ٔفٗ  فٙ انظٕسح A.6ئنٛٓب ة 

ؽبنخ اٌ سؼخ انًهف رغبٔصد 

انؾغى انًزبػ ٚهضو ػهٗ 

انششكخ اٌ رمهم ؽغى انًهف 

 downsizingثبسزخذاو ثشايظ 

ٔرانك نزخفٛف انؼغؾ ػهٗ 

م ٔالاسزخذاو الايض serversال

 نهًٕاسد انًزبؽخ

انًشبس ئنٛٓب ة ركهفخ انـهت 

6.B فٙ انظٕسح 

يهخض انًشفمبد انًـهٕثخ 

فٙ انظٕسح  C.6انًشبس ئنٛٓب ة 

 ٌ:ٔ ركٕ

  ثبنهٌٕ الأخؼش فٙ ؽبنخ

يُبسجزٓب نهًؼبٚٛش 

 انًـهٕثخ

  ثبنهٌٕ الأؽًش فٙ ؽبنخ

ٔعٕد خـأ ٚشعٗ يشاعؼخ 

انجٛبَبد يشح أخشٖ فٙ 

ْزِ انؾبنخ نززًكٍ يٍ 

ئسسبل انـهت

اسسبل انـهت ٚزى ػذ ؿشٚك 

ٔ   Submit Requestانؼغؾ ػهٗ صس 

 فٙ انظٕسح D.6انًشبس ئنّٛ ة 



 Submit Requestثؼذ انؼغؾ ػهٗ 

سزظٓش سسبنخ رأكٛذ اسسبل 

 Yesانـهت لى ثبنؼغؾ ػهٗ 

ػُذ انُغبػ فٙ ادخبل عًٛغ 

انجٛبَبد ٔ رؾًٛم عًٛغ 

الأٔساق انًـهٕثخ )يغ يشاػبح 

انؾغى انًـهٕة نكم ؿهت( يغ 

ادخبل انشلى انًسهسم لإٚظبل 

انذفغ سزظٓش سسبنخ انُغبػ فٙ 

 اسسبل انـهت

 انًهف رفبطٛم 1.1.1

يهف ٚؾزبط رؼذٚلاد 1.1.1.1

ٚشعٗ يشاػبح يٕػذ اسسبل انـهت ٔرنك نلانزضاو ثبنغذٔل انضيُٙ انخبص 

ثكم ؿهت نزغُت ئنغبء انـهت

ٕٚو  33فٙ ؽبنخ انًٕاد انغذٚذح ٚكٌٕ نهششكخ يؾبٔنزبٌ فٙ خلال  -

ػًم يٍ ربسٚخ ئسسبل انـهت لإسسبل انزؼذٚلاد يمسًخ كبنزبنٙ: 

ٕٚو  15ٕٚو ػًم ٔ يؾبٔنخ أخٛشح فٙ صبَٙ  15يؾبٔنخ فٙ أٔل 

ٕٚو ػًم ٚغؼم نهششكخ  15ػًم )ػذو اسسبل انزؼذٚلاد فٙ أٔل 

يؾبٔنخ ٔاؽذح لإسسبل انزؼذٚلاد(

فٙ ؽبنخ انًؼذنخ يٍ انُٕع الأٔل ٔ انضبَٙ ٚكٌٕ نهششكخ يؾبٔنخ  -

أٚبو ػًم يٍ ربسٚخ ئسسبل انـهت لإسسبل  5ٔاؽذح فٙ خلال 

انزؼذٚلاد 

ٚهضو ػهٗ انششكخ انزبكذ يٍ اسزٛفبء   extension  ٔv3فٗ ؽبنخ  -

انجٛبَبد ٔ الأساق انًـهٕثخ ؽٛش اَّ نٛس نذٚٓى فشطخ 

نهزؼذٚلاد

سٛزى ئنغبء انـهت رهمبئٛبً يٍ لجم الإداسح انؼبيخ نزُظٛى يٕاد 

انزسٕٚك ٔ الإػلاٌ فٙ ؽبنخ اسزُفبر انًؾبٔلاد أٔ ػذو انزضاو انششكخ 

 نزؼذٚلاد فٙ انًٕػذ انًؾذدثبسسبل ا



 انًًٓخ رخظٛض 1.1.1.1.1

ؽزٗ ٚزًكٍ انشخض انًسإٔل يٍ ئعشاء انزؼذٚلاد انًـهٕثخ ػهٗ أ٘ يٍ 

ٔئػبدح اسسبل انـهت  انـهجبد انًٕعٕدح فٙ لبئًخ انؼًم انخبطخ ثك

" كًب ْٕ يٕػؼ فٙ انظٕسAssign To Myselfٚغت أٔلاً انؼغؾ ػهٗ صس ال  "

 Assign انًًٓخػُذ اخزٛبس رؼٍٛٛ 

to Myself  ٚظٓش ثؼذ رنك سسبنخ

رأكٛذٚخ ؽٛش ٚزى رأكٛذ انشسبنخ 

 "Yesثبخزٛبس "

Yesػُذ ئخزٛبس 

ػُذ رأكٛذ رؼٍٛٛ 

انًًٓخ رظٓش سسبنخ 

انزأكٛذ كًب فٙ ْٕ 

 يٕػؼ فٙ انظٕسح

ػُذ فزؼ أ٘ يٍ انـهجبد انزٙ رظٓش فٙ لبئًخ انؼًم انخبطخ ثك      2.1.2.1.2

“Worklist” ٕػهٗ انزفبطٛم انزبنٛخ ٘سزؾز: 

ٔ يؼهويبث ػٍ انغهب .1

انز٘ ٚؾزٕ٘ ػهٗ 

 رفبطٛم ػٍ سٛش انؼًم

ٔ انز٘  يهخص انغهب .1

ثٛبَبد ػٍ ٚؾزٕ٘ ػهٗ 

 -انًهف يضم ) انشلى 

َٕع  -اسى انششكخ 

 انًٕاد انذػبئٛخ(



 تفبصَم ػٍ انغهب .3

“Details”  ٕ٘انزٙ رؾز

ثٛبَبد ثخظٕص ػهٗ 

انًهف ٔالأٔساق انزٙ 

 رى سفؼٓب

يزاجؼت انتؼهَمبث  .4

”Preview“:  ٚزى

يشاعؼخ انزؼذٚلاد 

انًـهٕثخ يٍ انًشاعغ 

انخبص ثبنـهت ػهٗ 

الأٔساق انًشفٕػخ يٍ 

 "Previewخلال اخزٛبس "

ٔ رظٓش كًب فٙ 

انخـٕح انزبنٛخ

ٔساق انًؾًهخظٓش الأر .5

ثؼذ ثٓزا انشكم 

 Previewانؼغؾ ػهٗ 

نٛزًكٍ انًشاعغ يٍ 

 يشاعؼخ يؾزٕ٘ انًهف

 خٔ انزؼهٛمبد انًشفم

يزاجؼت تبرٍخ الأوراق  .6

ٚزى  :Historyانًزسهت 

يشاعؼخ ربسٚخ الأٔساق 

انزٙ رى ئسسبنٓب يٍ 

ثذاٚخ انـهت يٍ خلال 

ٔ  "Historyاخزٛبس "

رظٓش كًب فٙ انخـٕح 

 انزبنٛخ



فٙ ؽبنخ انؼغؾ ػهٙ  .7

History  ٚظٓش ربسٚخ

 انًهف ثٓزا انشكم

انجذول انشيٌُ نهغهب  .8

”“Timeline  ٘انز ٔ

ٚؾُٕ٘ ػهٗ انًشاؽم 

انزٙ يش ثٓب انـهت ٔ 

فٙ ؽبنخ ئسسبل 

رؼهٛمبد ػبيخ يٍ لجم 

انًشاعغ ػهٗ انـهت 

فٙ أ٘ يٍ يشاؽم 

انـهت سزظٓش فٙ ششٚؾ 

انغذٔل انضيُٙ

 تفبصَم انًُتج .9

 “Product  Details”ٚظٓش 

ػٍ ثٛبَبد ُْب

 يضم انًُزظ

 ئَزٓبء ربسٚخ)

 شكم, انزسغٛم

 ؽبنخ, انغشػخ

 (انزسغٛم



ػُذ انضغظ ػهي ارسبل  .11

 رظٓش ”Submit“انغهب 

 انًزبؽخ انخـٕاد

كًب  ؿهت كم ػهٗ

فٙ انخـٕاد 

 انزبنٛخ

فٙ ؽبنخ سفغ ؿهت يٍ  .11

الاسزمجبل ثؼذ يؼشفخ 

ٔيشاعؼخ انـهجبد )يٍ 

" انخبص Previewخلال "

ثكم يسزُذ( ٔ 

انزؼهٛمبد انخبطخ 

ثبنًشاعغ )يٍ خلال 

ششٚؾ انغذٔل انضيُٙ 

 Timeline انخبص ثبنًهف

( ركٌٕ انخـٕاد 

 Toانًزبؽخ ْٙ 

Reception Pharmacist

فٙ ؽبنخ ئسعبع انـهت .11

نهزؼذٚلاد يٍ لجم 

ثؼذ طٛذنٙ انفؾض ٔ 

يؼشفخ ٔيشاعؼخ 

انـهجبد )يٍ خلال 

" انخبص Previewال"

ثكم يسزُذ( ٔ 

انزؼهٛمبد انخبطخ 

ثبنًشاعغ )يٍ خلال 

ششٚؾ انغذٔل انضيُٙ 

انخبص ثبنًهف( ركٌٕ 

انخـٕاد انًزبؽخ ْٙ 

كبنزبنٙ يغ الأخز فٙ 



الإػزجبس أَّ ٚؾك 

نهششكخ ؿهت الاسزؼبَخ 

ثبنهغُخ نزمٛٛى 

انًٕاد انغذٚذح ٔ 

فمؾ فٙ  ْزا ٚكٌٕ

انًؾبٔنخ الأٔنٗ فٙ 

 ٕٚو ػًم 15أٔل 

كًب ًٚكُك أٚؼب ؿهت .13

ػهٗ لشاس  اسزئُبف

ؿهت  فٙ ؽبنخ انهغُخ

انششكخ الاسزؼبَخ 

ثبنهغُخ فٙ انًؾبٔنخ 

سعٕع انـهت  الأٔنٗ

نهششكّ نهًشح 

انضبَٛخ ػٍ ؿشٚك 

 Requestاخزٛبس "

Appeal" 

ثؼذ اخزٛبس انخـٕح .14

يٍ انخـٕاد انًزبؽخ 

كًب ْٕ يٕػؼ فٙ 

انُمبؽ انسبثمخ ٚزى 

سفغ الإسزكًبلاد 

انًـهٕثخ ػهٗ انـهت 

فٙ ؽبنخ ؿهت ٔ 

انًشاعغ انًضٚذ يٍ 

انًسزُذاد أٔ سغجخ 

انششكخ اسسبل يشاعغ 

اػبفٛخ ٚزى اػبفزٓب 

" Extra Attachmentsفٙ "

كًب ْٕ يٕػؼ ثبنظٕسح



ػُذ ئسعبعيهؾٕظخ:  .15

انـهت نهششكخ ٚغت 

ػهٗ انششكخ اػبدح 

سفغ ئٚظبل انذفغ ٔ 

ادخبل انشلى انًسهسم 

 انخبص ثّ

ػُذ انُغبػ فٙ رؾًٛم .16

عًٛغ انًسزُذاد 

ٔالأٔساق انًـهٕثخ يٍ 

انًشاعغ ٚغت انؼغؾ 

"  لإسسبل Confirmػهٗ "

 انـهت

ثؼذ اسسبل انـهت .17

رظٓش سسبنخ نزأكٛذ 

انُغبػ فٙ اسسبل 

انـهت كًب ْٕ يٕػؼ 

فٙ انظٕسح

يهف ٚزى يشاعؼزّ 1.1.1.1

فزؼ أ٘ يٍ انـهجبد انزٙ رظٓش فٙ لبئًخ رمشٚش ؽبنخ ػُذ 

سزؾزٕ٘ ػهٗ انزفبطٛم انزبنٛخ يغ  Status Update Report انـهت

 ػذو ايكبَٛخ اعشاء أ٘ رؼذٚلاد ػهٗ انـهت



يهف رى يشاعؼزّ ٔ ئطذاس يٕافمخ أٔ ئنغبئ2.1.2.3ّ    

ػُذ الاَزٓبء يٍ 

انـهت ٔانًٕافمخ 

ػهّٛ أٔ ئنغبئّ 

انشكم  ٚظٓش ثٓزا

ػُذ انششكّ ٔ 

رسزـٛغ انششكخ 

رؾًٛم انًٕافمخ 

الإنكزشَٔٛخ ثبنؼغؾ 

" Downloadػهٙ صس "

ػُذ انؼغؾ ػهٗ صس 

"Download رظٓش "

طفؾخ عذٚذح رؾزٕ٘ 

ػهٗ انًٕافمخ ٔ 

انزٙ رؾزٕ٘ ػهٗ ال 

"QR code انًًٛض "

نكم يٕافمخ أٔ 

ئنغبء ثبنشكم 

انزبنٙ

ًٚكُك رؾًٛم كًب 

 انًٕافمخ ثبنؼغؾ

ػهٗ أٚمَٕخ 

انزؾًٛم فٙ أػهٗ 

 ًٍٚٛ انظٕسح



شكوً عهب 1.1

انشكبٔ٘

ْٕ كًب انمبئًخ

 ثبنظٕسح يٕػؼ

 ْزِ فٙ

 رظٓش انمبئًخ

انشكبٖٔ عًٛغ

 انمبئًخ

 يٍ انًشسهخ

 انششكخ لجم

 الإداسح ئنٙ

 نزُظٛى انؼبيخ

 انزسٕٚك يٕاد

الإػلاٌ ٔ

انشكبٔ٘ 

 كًب انًُزٓٛخ

 يٕػؼ ْٕ

 فٙ ثبنظٕسح

 انمبئًخ ْزِ

 عًٛغ رظٓش

انشكبٖٔ

ٔ انًُزٓٛخ

 انُظش رى انزٙ

 لجم يٍ فٛٓب

 انؼبيخ الإداسح

 يٕاد نزُظٛى

ٔ انزسٕٚك

 الإػلاٌ



 ؿهت شكٕٖ عذٚذ

لإَشبء ؿهت 

عذٚذ لى 

ؼغؾ ػهٙ صس ثبن

New Complaint 

رمٕو انششكخ 

ثبخزٛبس َٕع 

انشكٕٖ: شكٕٖ 

ػٍ يبدح 

 Reportدػبئٛخ 

Material  ٔأ

 شكٕٖ ػبيخ

Feedback

ٚزى ئدخبل 

انزفبطٛم 

انًـهٕثخ 

انًؾذدح 

 ثبنهٌٕ الأؽًش

ػهٗ شكم َض 

 فًٛب ػذا:

 رلى

 انتهَفوٌ

ٚزى ادخبنّ 

ػهٗ ْٛئخ 

 أسلبو

 تبرٍخ

ٚزى  انوالؼت

ادخبل 

انزبسٚخ يٍ 

لبئًخ 

 Reportشكوى ػهي يبدة دػبئَت أو تؼهًََت أو توػوٍت ػُذ إختَبر 

Material 

Submit Complaintٚزى ادخبل انجٛبَبد انًـهٕثخ فٙ رمٛٛى انشكٕٖ  :أٔلاً 

 انًؾذدح ثبنهٌٕ الأؽًش Check listٚزى سفغ الأٔساق انًـهٕثخ صبَٛبً 



انزٕاسٚخ 

انًشفمخ 

 ثبنخبَخ

ٚزى ئدخبل َض 

انشكٕٖ انؼبيخ 

فٙ رفبطٛم 

انشكٕٖ صى 

انؼغؾ ػهٗ صس 

 اسسبل انًهف

  Feedbackتشكوً ػبيػُذ إختَبر 

ػُذ  الاَزٓبء 

يٍ ئدخبل 

انزفبطٛم 

ٔالأٔساق 

انًـهٕثخ ٚزى 

رفؼٛم صس 

"ئسسم انًهف" 

ػُذ انؼغؾ 

ػهّٛ رظٓش 

سسبنخ نزأكٛذ 

رمذٚى  انشكٕٖ 

 ثبنشكم انزبنٙ

ٔ ٚزى انؼغؾ 

Yesػهٗ 



ٚزى انؼغؾ ػهٗ 

"Yes نزأكٛذ "

اسسبل انشكٕٖ 

ٔ ظٕٓس سسبنخ 

رأكٛذ انُغبػ 

فٙ اسسبل 

انشكٕٖ 



Archive الأرشَف 1.2

نسٕٓنخ انٕطٕل ئنٙ انـهجبد انًُزٓٛخ ٚزى ؽفظٓب فٙ شكم أسشٛف 

ٚؾزٕ٘ ػهٙ كبفخ انـهجبد انًُزٓٛخ 

انـهجبد 

انًُزٓٛخ 

انزٙ رى 

انًٕافمّ 

 ػهٛٓب

Approved

انـهجبد 

انًُزٓٛخ 

رى انزٙ 

يٍ   سفؼٓب

 الإسزمجبل

Rejected 

انـهجبد 

انزٙ رى 

 ئنغبئٓب

Cancelled



ئػبفخ يٕظفٍٛ نهششكخ 1.3

نهزٕعّ ئنٙ طفؾخ انًٕظفٍٛ ًٚكُك انؼغؾ ػهٙ ْزا انضس انًٕعٕد فٙ 

َٓبٚخ انمبئًخ ػهٙ انٛسبس

رظٓش انظفؾخ انزبنٛخ انزٙ ًٚكٍ نهششكخ يٍ خلانٓب انزؾكى فٙ 

ئػبفخ يٕظفٍٛ عذد ػٍ ؿشٚك انؼغؾ ػهٙ صس انًٕظفٍٛ انؾبنٍٛٛ ٔ 

"Addانزؾكى فٗ اَشبء اسى ًٚكٍ نهششكخ  ؽٛش " أػهٙ ًٍٚٛ انظفؾخ

ًٚكُّ انذخٕل ػهٗ ٔ يسزخذو ٔكٕد خبص ثّٛ ربثغ نهًسزخذو الاسبسٙ 

 PROMATثشَبيظ ال 

خظبئض رؾذ الإَشبء 1.4

 انخبطخ انخظبئض فٙ انزبنٛخ انخظبئض ئَشبء ػهٗ انؼًم الاٌَ ٚزى

:ثبنششكخ

 الأؽذاس انزٙ سزمٕو ثٓب انششكخ

نزُظٛى نلإداسح انؼبيخ ئيكبَٛخ ئسسبل رُجّٛ   PROMATسٛزٛؼ ال 

الإػلاٌ ثغًٛغ الأؽذاس ٔ انفؼبنٛبد انزٙ سزمٕو ثٓب يٕاد انزسٕٚك ٔ 

انششكخ



 انـهجبد انًؾفٕظخ

ئيكبَٛخ رؾًٛم ٔ ؽفظ انـهت ػُذ ئدخبل انجٛبَبد  PROMATسٛزٛؼ ال 

يٕاد نزُظٛى نلإداسح انؼبيخ انخبطخ ثبنًبدح ٔ اسسبنّ فٙ ٔلذ لاؽك 

انزسٕٚك ٔ الإػلاٌ 

انششٚؾ انًٕػؼ فٙ انظٕسحٔ سزظٓش عًٛغ انـهجبد انًؾفٕظخ فٙ 




